Introduction to NVivo 12 – Part I

Education Commons Workshop

OISE/University of Toronto, Room 3-320

Instructor: Olesya Falenchuk
Research Systems Analyst
Research Design and Analysis Services
3-223, Education Commons, OISE/UT
(416)978-1956
olesya.falenchuk@utoronto.ca

Location of data files: webspace.oise.utoronto.ca/~falenchu/

For official receipts, please, email oise.researchworkshops@utoronto.ca
Description of the workshop

NVivo 12 is a software package for analysis of qualitative data, such as transcripts of in-depth interviews, focus groups and field notes, data from electronic web surveys, audio, video, and social media data. The purpose of this workshop is to introduce participants to the NVivo 12 Suite, discuss the key differences between different versions of this software, as well as to provide participants with an opportunity to acquire some hands-on experience. Specifically, the participants will learn how to prepare their text, survey, and media data for analyses with NVivo 12, import and organize their data in NVivo, add research notes while analyzing the data, and code qualitative data in a variety of different ways. This workshop is appropriate for beginner researchers with no previous knowledge of NVivo as well as those who would like to expand their knowledge and skills with this software.

Components of Qualitative Data Analysis ¹:

- Data reduction – selecting, focusing, simplifying, abstracting, and transforming the data that appear in written-up field notes or transcriptions, further reduction through writing summaries, coding, teasing out themes, making clusters, making partitions, writing memos
- Data displays – matrices, graphs, charts, and networks, and other forms that allow to assemble organized information into an immediately accessible, compact form so that the analyst can see what is happening and either draw justified conclusions or move on to the next step of analysis
- Conclusion drawing/verification – noting regularities, patterns, explanations, possible configurations, causal flows, and propositions.

Features of NVivo environment:

- Helps to handle a research project with up to 10,000 documents
- Works with textual data in any language
- Allows to conduct collaborative research when multiple researchers work with the same documents
- Offers flexible customizable environment and security features
- Work with wide range of data formats (documents, PDFs, spreadsheets, images, audio, and video)
- Easily interchange data with applications like Microsoft Excel, Word, IBM SPSS Statistics and EndNote
- Work simultaneously with other researchers on the same project using NVivo Server
- Capture and work with web pages and online PDFs
- Import Facebook posts, LinkedIn discussions and tweets from Twitter
- Automatically code social media data; quickly and easily visualize the results
- Work with content like memos, photos and web clips from Evernote
- Works with spreadsheets and database tables
- Numerous visualization tools like word trees, tree maps, connection maps and cluster analysis
- Ability to import literature reviews and generate bibliographies by sharing data with tools like EndNote, Zotero and RefWorks
- NVivo allows you to open and work with projects from previous versions of QSR software: NVivo 8, NVivo 7, NVivo 2, NVivo 1, N6 (NUD*IST 6), N5 (NUD*IST 5) and N4 (NUD*IST 4)
- NVivo allows you to open and work with projects from other qualitative data analysis packages (MAXQDA and Atlas.ti)

What you can do with NVivo:

• Manage your entire project in one place—gather your data, project documentation, and analytical notes in one secure project file
• Work with your colleagues on the same project at the same time on NVivo Server
• Import and analyze data in a variety of formats
• Manage your bibliography by importing data from EndNote, Zotero and RefWorks. You can also build a bibliography in NVivo and export it to these programs
• Code your data efficiently
• Organize your themes (codes)
• Discover relationships between themes and characteristics of people and places
• Use a variety of text analysis tools to find meaning in unstructured data
• Run queries to explore trends and relationships between your themes
• Visualize your findings with a variety of tools
• Export your data and use them in other applications like MS Word and Excel, SPSS and EndNote
• Share your findings by running customized reports or by saving your nodes and data files as HTML pages

Versions of NVivo 12 software

There are two different versions of NVivo 12 for Windows software (NVivo Pro and NVivo Plus). In addition, there is a separate version of NVivo for Mac software. Each version of NVivo software features a different level of functionality to support a range of projects and research needs. Below is a comparison of the features across the three versions of NVivo software (adopted from QSR International website http://www.qsrinternational.com/nvivo/nvivo-products/nvivo-product-suite-overview).

<table>
<thead>
<tr>
<th>Compare the NVivo Suite</th>
<th>NVivo for Mac</th>
<th>NVivo 12 for Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NVivo Pro</td>
<td>NVivo Plus</td>
</tr>
<tr>
<td><strong>Data Files</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text Documents</td>
<td>☒</td>
<td>☒ ☒ ☒</td>
</tr>
<tr>
<td>Collect and import text documents in TXT, RTF, DOC, DOCX and PDF formats; Supports Editable Text.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Images</td>
<td>☒</td>
<td>☒ ☒ ☒</td>
</tr>
<tr>
<td>Collect and import images such as photos and scanned documents in BMP, GIF, JPG, TIF and PNG formats; Use the picture log to make notes and comments.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio and Video</td>
<td>☒ ☒ ☒ ☒ ☒ ☒</td>
<td></td>
</tr>
<tr>
<td>Collect and import audio and video recordings in MP3, WMA, WAV, M4A, MPG, MPE, WMV, AVI, MOV, QT, MP4, 3GP, MTS and M2TS formats; work with editable synchronized transcripts and view waveform visualizations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Datasets</td>
<td>☒ ☒ ☒ ☒ ☒ ☒</td>
<td></td>
</tr>
<tr>
<td>Collect data in spreadsheets and surveys and import in TXT, XLS, XLSX and ODBC formats; Display data in Form or Table Views.</td>
<td>XLS, XLSX, Display as Table View</td>
<td></td>
</tr>
<tr>
<td>Webpages</td>
<td>☒</td>
<td>☒ ☒ ☒</td>
</tr>
<tr>
<td>Use NCapture to capture web pages as they appear within a browser and import as a PDF.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Social Media</td>
<td>☒</td>
<td>☒ ☒ ☒</td>
</tr>
<tr>
<td>Import comments from Twitter, Facebook and YouTube. Import videos from YouTube to view and explore.</td>
<td>Twitter, Facebook</td>
<td></td>
</tr>
<tr>
<td>Emails</td>
<td>☒</td>
<td>☒ ☒ ☒</td>
</tr>
<tr>
<td>Import emails from Microsoft Outlook and automatically create cases and relationships between recipients and senders.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Interoperability</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qualitative Analysis Software</td>
<td>Use NVivo for Windows to convert projects to NVivo for Mac format.</td>
<td>☒ ☒ ☒ ☒</td>
</tr>
<tr>
<td>Convert and work with projects created in software by QSR, Atlas.ti, MaxQDA and Framework.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference Management Software</td>
<td>☒ ☒ ☒ ☒ ☒ ☒</td>
<td></td>
</tr>
<tr>
<td>Import bibliographical data, notes and article attachments from reference management software: EndNote, Mendeley, RefWorks, Zotero.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistical Analysis Software</td>
<td>☒ ☒ ☒ ☒ ☒ ☒</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compare the NVivo Suite</td>
<td>NVivo for Mac</td>
<td>NVivo 12 for Windows</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>---------------------</td>
</tr>
<tr>
<td></td>
<td>NVivo Pro</td>
<td>NVivo Plus</td>
</tr>
<tr>
<td><strong>Import and export delimited text files and spreadsheets to and from applications like Microsoft Excel, Microsoft Access and IBM SPSS Stats,</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note-taking Software</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export notes directly from Evernote and OneNote and bring them into NVivo with the same structure set up in your note-take software. Collect notes on-the-go using Evernote on devices like tablets and phones, and then easily import data directly into NVivo via API.</td>
<td>OneNote Online</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Online Survey Software</strong></td>
<td>Generic Survey Formats</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Import survey responses and demographic data directly from SurveyMonkey and Qualtrics. Supports SurveyMonkey API and Generic Survey Formats.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Generic Formats</strong></td>
<td>TXT, CSV</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Collect, import and export data in HTML, XML, XLS, XLSX and TXT formats.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transcription</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order transcripts from TranscribeMe and find them automatically synced to your media file in your NVivo project.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Social Media</strong></td>
<td>Twitter, Facebook</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Collect data from people, organizations and groups published on Twitter, Facebook or Youtube.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Social Network Analysis</strong></td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td>Build and analyze links between people or other entities. Visualize the connections between a population and derive further insight through network metrics. Supports PAJEK.</td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td><strong>Data Management</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a paperless filing system allowing you to easily search, sort and access project items using Folders, Search Folders and Sets.</td>
<td>Folders, Sets</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Transcription</strong></td>
<td></td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Import an existing transcript, or create one within NVivo, and link to its corresponding audio or video file.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Reliability</strong></td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td>Store your project data and material in a single file, making your project completely portable.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>User Profiles, User Passwords, Encoded Storage</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Enhance security by protecting access to projects with User Profiles, User Passwords, and Encoded Storage.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scalability</strong></td>
<td>512GB Project Files</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Work with larger amounts of data in a single project (up to 10GB) or remove limits with NVivo for Teams.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Traceability</strong></td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td>Keep track of what team members are doing by recording changes to a project with an audit log of user actions.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Recoverability</strong></td>
<td>Multiple levels of Undo for selected features</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Explore your data with confidence knowing you can retrace your steps with multi-level undo and automatic back up and recovery of your data. Includes multiple levels of Undo, Project Repair, Project Restore, Automatic Backup (with NVivo for Teams).</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Analysis</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categorize and classify data by theme or topic and analyze how items are connected using In-Vivo Coding, Thematic Hierarchical Coding and Relationship Coding. Enhanced for Mac.</td>
<td>In-Vivo Coding, Thematic Hierarchical Coding</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Case Coding</strong></td>
<td></td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Gather references to People, Places, Organizations and other entities and categorize and classify data to analyze the who, what and where questions.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Auto Coding by Structure</strong></td>
<td>Automatic Coding of Datasets</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td>Automatically categorize structured information like interview responses contained in datasets or documents formatted with paragraph styles.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Auto Coding by Speaker Name</strong></td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td>Automatically categorize interview and focus group responses contained in documents.</td>
<td>☑️ ☑️</td>
<td>☑️ ☑️</td>
</tr>
<tr>
<td><strong>Pattern-Based Auto Coding</strong></td>
<td></td>
<td>☑️</td>
</tr>
<tr>
<td>Automatically categorize and classify data based on existing coding patterns.</td>
<td></td>
<td>☑️</td>
</tr>
</tbody>
</table>

---

Note: Depending on the version of NVivo, certain features may be included or available as add-ons.
<table>
<thead>
<tr>
<th>Compare the NVivo Suite</th>
<th>NVivo for Mac</th>
<th>NVivo 12 for Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Classifications</strong></td>
<td></td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Assign Attributes like demographic data to Cases, or bibliographic data to Files. Assign colours to Project Items and see them throughout your project in Charts, Models and other visual tools.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Annotations</strong></td>
<td>Annotations for Documents and PDFs</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Create editable notes to comment on selected content.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Memos</strong></td>
<td></td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Record and store your insights, observations and interpretations and link them to the material you are analyzing using Memos for Project, Files and Nodes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>Hyperlinks</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Apply 'see-also' links to note a comparison or to lay a trail of evidence. Use Hyperlinks to link to web pages and files outside of your project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Framework Matrices</strong></td>
<td>✔ ✔ ✔</td>
<td></td>
</tr>
<tr>
<td>Use Framework Analysis to condense large volumes of data into a table summarizing the topics in your content.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Social Network Analysis</strong></td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>View Case Relationships and Social Media Interactions to explore social networks and answer questions about individuals' roles within a network, or study the network as a whole.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Automated Insights</strong></td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>Use Automated Analysis of Themes and Sentiment to automatically discover emerging themes and sentiment within your data in a matter of minutes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Exploration</strong></td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Text Search Query</td>
<td>Querying Words or Phrases with AND, OR, NEAR operators</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Query Words (and Stemmed Words), Phrases, or Concepts with AND, OR, NEAR operators to find an exact word match or words that are similar in meaning.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coding Query</td>
<td>Querying Coding with AND, OR operators</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Explore and ask questions about your coding to find overlaps and intersections using AND, OR and NEAR operators.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word Frequency Query</td>
<td>Querying Frequently Occurring Words</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>See a list of the words that appear most often within your materials by querying frequently occurring words or concepts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Matrix Coding Query</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Compare coded material across nodes, sets or attribute values by querying to Cross Tabulate Coding and/or Attributes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crosstab Query</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Compare Codes vs Attribute Values and Codes vs Cases.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Find in Content</td>
<td>✔ ✔ ✔</td>
</tr>
<tr>
<td>Locate project items by Criteria, Find by Name, Find in Content and group Find results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>Use pre-defined reports or create your own using a Wizard. Save reports and share with others.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Visualization</strong></td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Coding Stripes</td>
<td>Display Coding Stripes for Nodes. Print nodes and documents including coding stripes.</td>
<td>✔ ✔</td>
</tr>
<tr>
<td>Use colored stripes to view and compare coding or demographic information in your data. View and print Coding Stripes for Nodes, Attributes and Users.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charts</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Create and explore Charts including Column, Pie and Bar charts. Range of Customizable Charts for Project Items and their Associations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word Clouds</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>A customizable visual representation of Word Frequency Queries that displays the most frequently appearing words in selected materials or nodes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cluster Analysis</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>Use a range of Cluster Analysis Diagrams such as Dendrograms, Circle Graphs and Cluster Maps to visualize similarities and differences in Files and Nodes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word Trees</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td>See the most frequently appearing words in selected materials and nodes, and explore the context surrounding the words.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hierarchical Charts</td>
<td>✔ ✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Compare the NVivo Suite</strong></td>
<td><strong>NVivo for Mac</strong></td>
<td><strong>NVivo 12 for Windows</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>Visualize hierarchical patterns and prominent themes in your data with treemap and sunburst charts.</strong></td>
<td></td>
<td>☑ ☑</td>
</tr>
<tr>
<td><strong>Geo visualization</strong></td>
<td>Map where your social media contributors are located, based on information provided in their user profiles.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Explore Diagrams</strong></td>
<td>Visually explore project data through a dynamic diagram that shows connections between a central project item and its related project content. Step through the project items to reveal further connections.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Comparison Diagrams</strong></td>
<td>Visually compare two Files, Nodes or Cases to see what they have in common and where they differ.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Project Map</strong></td>
<td>Explore and visually analyze the connections in your Project Items.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Concept Map</strong></td>
<td>Freeform diagramming tool to represent concepts, ideas, and theories relating to your research project. Map out ideas, findings or theories and present them for sharing with others.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Mind Map</strong></td>
<td>Brainstorm your ideas and visualize your thoughts. Quickly develop a project structure at the beginning of your project.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Egocentric Sociograms</strong></td>
<td>Visualize how a particular central Case is connected to other Cases, and how those Cases are connected to each other.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Network Sociogram</strong></td>
<td>Visualize the connections, or lack of connections, between a group of Cases.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Social Media Sociograms</strong></td>
<td>Visualize Twitter datasets to see the network of Twitter users, and how they are connected by retweets and mentions.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Language Support</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Spelling Dictionary</strong></td>
<td>Check spelling as you edit new and existing files in NVivo in Simplified Chinese, English (US, UK), French, German, Japanese, Portuguese (Brazil) and Spanish (Mexico).</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Data Language</strong></td>
<td>Work with data in virtually any language including character based languages such as Japanese and Mandarin</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Query Dictionary Language</strong></td>
<td>Run Text Search and Word Frequency Queries in 7 languages: Chinese, English (US, UK), French, German, Japanese, Portuguese and Spanish.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>User Interface Language</strong></td>
<td>Work with a user interface in English, French, German, Japanese, Portuguese (Brazil), Simplified Chinese and Spanish (Mexico).</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Codebook</strong></td>
<td>A report of your coding structure, including descriptions, to show team members and align coding practices. Export in Word and Excel format.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Teamwork Support</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Merge Projects</strong></td>
<td>Merge separate projects in to one project file.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Multi-User Projects</strong></td>
<td>Allow team members to work in the same project at the same time and view each others changes immediately with NVivo for Teams.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Coding Comparison</strong></td>
<td>View coding of different users and compare to discover the degree of agreement for coding between users.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>User Assistance</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Getting Started Guide</strong></td>
<td>Get up and running fast with an introductory guide to learning fundamental tasks.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Online Help</strong></td>
<td>Online Help that provides step-by-step instructions for working with every feature of NVivo.</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Online Tutorials</strong></td>
<td>Step-by-step animated online video tutorials that demonstrate how to use NVivo.</td>
<td>☑</td>
</tr>
</tbody>
</table>
### Compare the NVivo Suite

<table>
<thead>
<tr>
<th>Feature</th>
<th>NVivo for Mac</th>
<th>NVivo 12 for Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample Project</strong></td>
<td>☑</td>
<td>☑ ☑ ☑</td>
</tr>
<tr>
<td>Provides a ‘real-life’ sample project that can be used as an example to explore how to organize data, and experiment with queries, visualizations and other analysis tools.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>System Administrator Help</strong></td>
<td>☑</td>
<td>☑ ☑ ☑</td>
</tr>
<tr>
<td>In-depth technical resources for System Administrators.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Community Resources</strong></td>
<td>☑</td>
<td>☑ ☑ ☑</td>
</tr>
<tr>
<td>Learn and communicate with peers and our Customer Support team in online social communities: User Forum, Facebook, LinkedIn User Group, Twitter, YouTube, Blog.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Update Notifications</strong></td>
<td>☑</td>
<td>☑ ☑ ☑</td>
</tr>
<tr>
<td>Receive automatic notifications when new updates are available to download and install.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Approaching a Research Project

#### Prepare Your Data

If you have structured documents – such as interviews where participants are all asked the same set of questions – format them using consistent paragraph styles to support auto coding. You can do the formatting in Microsoft Word before you import, or in NVivo after import.

When working with audio, video or picture data, consider any editing requirements before import. For example, if you have hours of video footage, you may want to edit it down to a manageable size – you cannot do this editing in NVivo. If you have many large videos, you can choose to store them outside the project so that software performance is not compromised.

Think about whether you will require transcripts for your audio and video files. They can be imported in .doc, .rtf, or .txt format or you can transcribe the media directly in NVivo. You can code directly in an audio/video or you can code the transcript.

#### Prepare for Teamwork

If you are working in a team, consider possible approaches. Team members can work on different data files or bring unique perspectives to the same data files – either way, you can easily merge the contributions made by all collaborators.

Each team member can work in their own project file or you can share a single project with other colleagues. Note that a project file can only be accessed by one person at a time.

Where coding consistency is important, agree on a node structure early and have regular discussions about how the structure is evolving. Create this structure in a ‘master’ project and import in into the separate project files. Use the Coding Comparison Query to regularly check for consistency between coders.

Give each team member a unique user profile – they are prompted to enter this when they first launch NVivo. This way you can track the updates and coding done by members of your team.

#### Gather Your Early Ideas

Make a project journal in NVivo. Use it to record your early goals, assumptions, theories and challenges. Keep track of your project as it evolves.
Use your NVivo project as a central place to store all preliminary materials such as client briefs, literature notes, grant applications, participant release forms and ethics protocols.

Create a model in NVivo to capture and visualize your theories or to aid your research design. If you have a research design, set up the data files, cases, and nodes to support it.

**Description of Practice Project**

For our practice we are going to use a hypothetical project (supplied with Nvivo 8). The goal of this project is to gain a better understanding of the impact of demographic change (particularly to the aging of the Baby Boomers) on why people volunteer, how they view volunteer opportunities, and how nonprofit agencies and other entities can better recruit and retain volunteers. For this project, the researchers conducted three interviews – with Anna (25 years old student), Bernadette (65 years old, retired) and Fredric (37 years old, working full time). The interviews were structured and each interviewee was asked the same questions in the same sequence:

**Q.1 Current use of time**
*In an “ordinary” week, how do you currently spend your time? (What takes most time, how much time spent on work, family, leisure etc…?)*

**Q.1a Feelings about current time use?**
*How do you feel about your time use now? Does it fit with your goals? Are there other things you’d like to fit in?*

**Q.2 Time use ten years on**
*Please think ahead, to your life ten years from now. How does your use of time look then? (What will your goals be then? Will you be employed? What will you do when you are not working…?)*

**Q.2a Feelings about future time use?**
*Does it fit with your goals? Do you expect to have enough time to do what you want to do?*

**Q.3 Volunteer work means?**
*“Volunteer work”: what does that phrase mean to you?*

**Q.4 Volunteering experience**
*Have you done any volunteer work? What did you do, and when? How was the experience? Would you do more in future?*

**Q.5 What sorts of people volunteer?**

**Q.5a Typical volunteer worker?**
*Can you describe a typical volunteer?*

**Q.6 Rewards for volunteer work**
*What do you think motivates volunteers? (What do they get out of it?)*

**Q.6a Incentives for volunteering?**
*What incentives should be offered for volunteering? If you were volunteering your time, how would you like to be thanked? Do you think volunteers should be paid for their costs?*

**Q.7 Images of volunteers**
*Interviewer: show Images of Volunteers card.*

**Q.7a Conservation in Sri Lanka**
*Your thoughts about Louise and her volunteer work?*

**Q.7b Housing in Honduras**
*Your thoughts about Ross and the work he is doing?*

**Q.7c Food program in Melbourne**
**Your thoughts about Katie and her volunteer work?**

**Q.8 About yourself**
*Please fill in the following details:*

Your gender?  
Your age?  
Your current job?  
Do you expect to be employed in 10 years’ time?  
Your highest level of education?  
Have you ever done volunteer work?  
Do you currently do any volunteer work?  
If you have done volunteering, what sort of organization have you volunteered for?  
What sort of an organization would you most like to volunteer for?

Another participant, Peter, was asked only question 7(a, b, and c). For question 7, all interviewees were presented with images of volunteers and were asked to reflect on them:

<table>
<thead>
<tr>
<th>Picture</th>
<th>Text</th>
</tr>
</thead>
</table>
| ![Louise](image1.jpg) | **This is Louise...**  
*Louise is in Sri Lanka in a series of conservation projects.*  
*Your thoughts about Louise and her volunteer work?* |
| ![Ross](image2.jpg) | **This is Ross...**  
*Ross is one of a team building housing in Western Highlands of Honduras.*  
*Your thoughts about Ross and the work he is doing?* |
| ![Katie](image3.jpg) | *... this is Katie.*  
*Her picture comes from a story in Melbourne.* |
In addition, questions 3 to 6a were organized in an online survey and 6 people responded to them.

Also, as part of this study a focus group with 6 non-volunteer participants was conducted. The focus group discussion was guided by the following questions:

**Defining volunteer work**
*To start, I have some questions about volunteer work. What does that phrase mean to you?*

**Reasons for not volunteering?**

**Rewards for volunteer work**
*What incentives should organizations offer to people who volunteer or do service for them?*  
*If you were volunteering your time, how would you like to be thanked?*  
*[Is saying thank you enough? Is knowing you’ve made a difference enough?]*

**What would consider?**
*What kinds of volunteer work would you consider doing? What types of volunteering might interest you?*

**What would motivate?**
*What would be a motivator for you to engage in volunteer work? What could agencies do to make it more appealing to you?*  
*[Facilitators: Get participants to think of some experience recently when you helped someone out - a family member or friend? How was this different from doing volunteer work?]*

And, finally, two focus groups with volunteers were conducted. The purpose of these focus groups was to define volunteering and learn about participants’ experiences.

**Project Data:**

1. Interview transcripts for Anna, Bernadette and Fredric (*Anna.doc*, *Bernadette.doc* and *Fredric.doc*)

**Today’s Goals:**

- Launch NVivo and create a project  
- Navigate around a project  
- Save and make a project backup  
- Import text data  
- Create new files  
- Organize data files into folders  
- Create thematic nodes  
- Manual coding of data  
- Auto coding of structured content  
- Review the content of nodes and make further decisions about it
• Create annotations
• Create memos
• Create linked memos
• Move, sort and merge nodes
• Export a node

**NVivo Project Environment**

*How to:*

- **Launch NVivo and create a project**
- **Navigate around a project**
- **Save and make a project backup**

**Launch NVivo and create a project**

When you open NVivo the **Welcome** screen is displayed. You can open an existing project or create a new one. If you want to continue working on your project, select it from the list of **Recent Projects** and click **Open Project**. If you want to start a new project, click the **Blank Project button** on the **Welcome** screen, enter the name of your project and click **OK**.
Task 1.

- Launch NVivo.
- In Welcome window, click on the Blank Project button.
- In the dialog window, under Title type Volunteering project.
- Click on the Browse button. In the dialog window choose the destination where your NVivo project file should be saved. Click OK.
- Check Write user actions to project event log option.
- Click OK.

Navigate around a project

Once the project is open, you will see the main NVivo window. The main NVivo window looks somewhat similar to Microsoft Outlook window (those who use Outlook will notice it). It is divided into three parts: Navigation View, List View, and Detail View. The Navigation View lists all the toolboxes available in NVivo and folders within each toolbox. The List View allows seeing the content of the folders. In Detail View, you can see the content of an open item.

Main NVivo window

On the top of the main NVivo window you can see a ribbon. The concept of the ribbon should be familiar to you if you use MS Office 2007 (or a later version). The ribbon is designed to help you locate commands. Tabs on the ribbon play a role of menus. Commands in the tabs are organized into logical groups. Each tab relates to a type of activity, such as creating new project items or analyzing your source materials. The Home, Import,
Create, Explore, and Share tabs are always visible. The other tabs are 'contextual'—they are shown only when needed. For example, the Document tab is shown only when a document content is visible.

The Navigation View provides access to all your project items. Items are organized under group buttons—for example, Data, Codes, Cases, and Notes. When you click on a folder in Navigation View, its contents are displayed in List View.

**Work Process in NVivo**

The work flow of the typical qualitative research process is outlined in a diagram below. This diagram contains the main tools NVivo offers for research analysts. The description of each element of this diagram follows in the next section of the handout.

![Diagram of NVivo work process](image)

**NVivo Tools in the Navigation View**

<table>
<thead>
<tr>
<th>Toolbox</th>
<th>Description</th>
</tr>
</thead>
</table>
| Data    | **Data** are your research or project materials (video recordings, transcripts, observation notes, memos capturing your thoughts and ideas, etc.). Data are categorized into two types:  
  - **Files**: primary source materials such as interview transcripts, audio files, video footage, photographs, or whatever other data are relevant to your project.  
  - **Externals**: 'proxy' sources representing material that you cannot import into NVivo (newspaper articles, books, web pages and so on). In an external, you can record notes or summaries relating to the material. If the external represents a file on your computer, you can link to and open the file. |
<p>| Codes   | <strong>Code</strong> can be thought of as a container for references related to a particular theme or concept. NVivo provides the following types of nodes: |</p>
<table>
<thead>
<tr>
<th>Toolbox</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nodes</strong>:</td>
<td>in this folder you can store thematic nodes either as a straight list, nodes that are catalogued in a hierarchical structure, or use a combination of both</td>
</tr>
<tr>
<td><strong>Relationships</strong>:</td>
<td>nodes that describe the connection between two project items. For example, the relationship between two cases (Monique and Jen work together) or between two nodes (Poverty impacts Health).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cases</th>
<th>Cases: items used to gather material about people or sites that have attributes such as gender or age.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Case classifications</strong>: definitions for categories of cases, such as teachers, parents, and children.</td>
</tr>
<tr>
<td></td>
<td><strong>Attributes</strong>: characteristics of the cases, such as gender, age, education, etc.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notes</th>
<th>Memos: records of your thoughts and observations. If a memo is related to a particular project item you can create a 'memo link’ to link the two together.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Memo links</strong>: use them to attach a memo to the file or node that is related to it.</td>
</tr>
<tr>
<td></td>
<td><strong>Annotations</strong>: like scribbled notes in a margin, annotations enable you to comment on selected content.</td>
</tr>
<tr>
<td></td>
<td><strong>See also links</strong>: use them to place pointers between the content of data files, nodes, models or sets.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Search</th>
<th>Queries: enable you to question your data, find patterns and pursue ideas. You can save queries, re-run them through new data and track the evolution of results.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Query results</strong>: store the results of queries</td>
</tr>
<tr>
<td></td>
<td><strong>Sets</strong>: provide a flexible way of grouping project items of different types. For example, you might create a set for the photographs and videos taken in a particular setting. You can customize the order of the items in a set to make a ‘virtual’ album or photo gallery.</td>
</tr>
<tr>
<td></td>
<td><strong>Search folders</strong>: store search results</td>
</tr>
</tbody>
</table>

| Maps | Maps can illustrate initial ideas about your project or identity emerging patterns and connections. Make a ‘static’ map to represent your project at a specific point of time. Make a ‘dynamic’ map to represent your project in real time. |

To use NVivo functions and tools you can use the ribbon or right-click mouse menus. Some functions also can be invoked by using hot key combinations (like Ctrl+C for copying, and Ctrl+V for pasting). Use the option that suits your working style.

**Save and make a project backup**

If you make a mistake while working in NVivo, you can undo your most recent actions. Note: there is no redo action in NVivo.

You can save your project at any time by hitting Ctrl+S, or by choosing the Save icon in the top left corner of the screen or by selecting the File > Save ribbon option. When you save your project, anything in the undo buffer is removed.

NVivo will display a Save Reminder for you every 15 min (default setting). You can choose to save your project at this time by clicking Yes. Also, you can change the settings for the Save Reminder by clicking on File > Options ribbon menu, and then selecting the Notifications tab and changing the settings.

An NVivo project is stored as a single file, so backing up your project is similar to backing up any important file which is stored on your computer. You need to make a copy to another location (USB memory device, Dropbox,
Google Drive, etc.). To make a copy of your NVivo project, save the project first, then select the File ribbon tab and choose Copy Project, select location and a name for the copy of your project, and click OK. If you add the current date to the name of the copied project, it will be easy to identify if you need to revert to a backup project.

With the ability to include very large media files, an NVivo project can get very large very quickly. To compress the size of the project file, use a compression utility such as WinZip. Note: data not embedded in your NVivo project, or linked to via externals will not be backed up as part of this process. You need to back these files up separately.

**Creating a New NVivo Project**

**How to:**
- Create a new standalone project
- Open existing NVivo project

**Create a new standalone project**

To create a new NVivo project in the main NVivo window, follow these steps:

1. Click the File tab, and then click New. The New Project dialog box opens.
2. Enter a name for this project in the Title box. Optionally, you can enter a description for this project in the Description box.
3. Click the Browse button on the File name box.
4. In the Save as type list, make sure NVivo Projects (*.nvp) is selected. Optionally, you can change the default file name and location.
5. Click Save and OK.

After this you can start working on your new project.

**Open existing NVivo project**

To continue working on an existing project, you can open a standalone project saved on your computer or a network drive, or you can open an NVivo Server project. You can open a standalone NVivo project by simply double-clicking on its name in the file directory on your computer or through the File tab in NVivo.

**Organizing Your Data in NVivo Project**

**How to:**
- Import data
- Create new data files
- Create folders

**Import data**

Data are your files or the research materials that you want to analyze. Your data can include electronic text documents, images, audio, video, survey, social media discussions and entries, etc. You can choose to import a single file of a particular type or multiple data files at the same time (except for survey data).
NVivo contains three default folders for your **Data: Files, File Classifications, and Externals**. These folders contain different types of data and help you to keep track of your research materials:

**Files:** your 'primary' research materials that you import or create.

**File classifications:** allow you to capture general information about your files - for example, interview date and location. If you conduct a literature review, you can import the literature references into NVivo - the bibliographical data is stored using 'file classifications'.

**Externals:** folder for the 'proxies' that represent materials that you cannot import such as books, websites or PowerPoint presentations - you can create an external (a text based file) and summarize the content of the item.

You can create your own folders under each of these default folders. For example, under Files you could create separate folders for Interviews, Focus Groups and Observations.

**Note:** You cannot delete or rename the default folders and you cannot create new folders at this level.

Once the data file is imported, you can open it from the List View and see in the Detail View. Any data file by default opens as ‘read-only’. You can make changes to a document by switching to the Edit Mode. When you work with a file in edit mode, you can:

- Add, delete and edit the text in documents, memos, externals, audio and video transcripts, and picture logs
- Apply paragraph styles to documents, memos and externals
- Apply text formatting to documents, memos, externals, audio and video transcripts, and picture logs
- Insert images and tables in documents, memos and externals

You cannot:

- Edit images or audio/video media content in NVivo. If you want to edit these materials—for example, reduce the length of an audio file—you should edit them outside NVivo, before you import them into your project.
- Switch to edit mode when you are working in a dataset. You cannot edit datasets in NVivo, so it is important to gather all the data you need before you import the data into NVivo.

**Import electronic text documents**

For most researchers, at least some of their data comprises textual documents derived from interviews, focus groups, observations, field notes, survey responses, policy documents etc. You can import files in the following formats into NVivo:

- Microsoft Word (.doc)
- Adobe Portable Document Format (.pdf)
- Rich Text
- Format (.rtf)
- Text (.txt).

Before you start qualitative analyses with NVivo, you have to prepare your data. First, you have to ensure that your data is in text-based, electronic format. So, if you are performing a content analysis of paper-based texts such as policy documents, you may need to use a scanner with optical character recognition (OCR) software to transform the documents to electronic format.
You should save each piece of qualitative information (interview or focus group transcript, observation notes, or paper-based document) as a separate file. Each file should be given a name that allows you quickly identify its content.

If you have structured documents—such as interviews, where participants are all asked the same set of questions—format them using consistent paragraph styles to support auto coding. You can do the formatting in Microsoft Word before you import, or in NVivo after import.

To import electronic text documents:
1. In Navigation View, click the Files folder (or a subfolder under it) to locate the destination for imported files.
2. On the Import tab of the ribbon, in the Data group, click Files. The Import Files dialog box opens.
3. In the Import from box, click the Browse button, select the file you want to import and
4. Click Open.
5. Click OK.

To import multiple data files simultaneously, choose multiple consecutive files in theBrowse window by keeping Shift key pressed and selecting the first and the last file of the group. If you want to select multiple non-consecutive files, keep Control key pressed and select the files with your mouse.

Note: Some elements of Word documents are not imported. For example, headers and footers in Word documents are not imported.

**Task 2.**
- On the Import tab of the ribbon, in the Data group, click Files. The Import Files dialog box opens.
- In the Import from box, click the Browse button, select all files in Microsoft Word and PDF format from the workshop folder (you can select multiple files by keeping the Shift button pressed) and click Open.
- Click OK.

**Create new data files**

It is not necessary to have your data files prepared before importing to NVivo. You can create a new document or transcript directly in NVivo. As well, you can create a new External or Memo.

To create a new document in NVivo:
1. In Navigation View, click the folder for the new document.
3. Enter a name for the document, and, optionally, a description.
4. Click OK. The document will open in edit mode and you can enter the content.

Similarly, you can create a new external data source or a memo by selecting a corresponding option from the Create group.

**Task 3.**
- Enter a name for the document Questions for NVivo Part I workshop.
- Click OK. The document will open in edit mode and you can enter the content.
Create folders

When all your data files are imported to your NVivo project, you might want to organize them by groups – for example, by the type of the document (interview transcripts, audio and video files) or by site (Toronto, Vancouver, Ottawa).

Let’s say you’ve decided to organize your documents by type. The documents that you just imported to your new NVivo project can be categorized into two groups: Text Documents and Articles. The first step in organizing your data is to create two folders for these groups of documents, and the second step is to move each document to a corresponding folder.

To create a folder:
1. On the Create tab, in the Folder group, choose Folder. This will open New Folder dialog window.
2. Enter the name of the folder and description (optionally), and click OK.

Repeat these steps to create all folders for your project. Once these folders are created, you will see them in the Navigation View for Data nested within Files. Move each file to a corresponding folder by clicking on it and dragging and dropping. After you finish this step, click on each of the folders and verify that it contains the documents that fit into the category specified by the Folder name.

Task 4.
- On the Create tab, in the Folder group, choose Folder. This will open New Folder dialog window.
- Enter Interviews as the name of the folder and click OK.
- In the same way create folders titled Focus Groups, Articles, and Project Documentation.
- Move all the files that you’ve imported earlier to their corresponding folders. You can do it either by drag-and-dropping or by cut-and-pasting (either by using Cut and Paste tools in the Home tab of the ribbon, or by using CTRL+X and CTRL+V hot keys).

TIP: The folders are organized alphabetically; therefore, your Project Documentation folder might be placed between folders containing your data. If you find it inconvenient, you might want to rename this folder into _Project Documentation – it will appear as a first folder in your documents.

Recording Your Insights and Ideas

How to
- Create annotations
- Create memos
- Create linked memos
- Create “See also” links

Some of the most important research material comes from your own thought process as you work with your data. These ideas and comments are often recorded in notebooks or jotted down in the margins of documents. You may also collect observation notes about the person you are interviewing which is important to keep together with your data. In NVivo you can use annotations and memos to document your spontaneous thoughts, ideas related to the research, reflections on the project etc.
Create annotations

Your first reading of a document should be rapid, but purposeful, directed but not bound by your research questions. The idea is to get a sense of the whole, so that as you begin to identify specific points or issues in the data, you will see those in the context of that whole. Make notes about what you think this document is telling you, reflect on a word or phrase, and record your ideas. As you read a document, you might want to annotate words or phrases in the text. Annotations in NVivo work rather like a comments field or a footnote in Word, they are useful for notes about a particular segment of the text. Like scribbled notes in the margin, annotations let you record comments, reminders or observations about specific content in a data file or node. Annotated content in NVivo files is highlighted in blue and the text of the annotation is displayed in the Annotations tab at the bottom of the window.

Type of content you can annotate in different types of files:
- **Text**: single letter, word, sentence, passage, entire file, embedded image or table content
- **Survey dataset**: codable fields (columns)
- **Audio and video**: a section of the media via the timeline, or text in the Content column of a transcript (if you have one)
- **Image**: a region of the picture, or text in the Content column of the picture log (if you have one)

To add an annotation to a file:

1. Open the file.
2. Select content you want to annotate (to add an annotation to audio or video timeline, click and drag to select the required timespan on the timeline).
3. On the **Document** tab, in the **Annotations** section select **New Annotation**.
4. An empty field will open on the bottom of the screen. You can write your notes in it.

The annotated text will become highlighted in blue. Later, you can make the field with annotations invisible by unselecting **Annotation** option in the **View** section of the **Document** tab.

**Task 5.**

We are going to practice this tool with the transcript of the interview with Fredric.

- Open the document *Fredric* in the **Interviews** folder of the **Files**.
- Select the first sentence *Well, five days of the week are real work.*
- On the **Document** tab, click on the **New Annotation**.
- An empty field will open on the bottom of the screen. Write *This is a very interesting choice of words, obviously volunteering is still considered "work" but not "real" work. Where is this distinction?*
- Select the last sentence in Fredric’s answer to Q5a: *But you know, I think that's more a self-indulgent thing, a chance to travel, and maybe your parents put in some of the costs because they see it as Developing You.*
- On the **Document** tab, click on the **New Annotation**.
- An empty field will open on the bottom of the screen. Write *This is said very ironically and he laughs.*

Create memos

Memos are a type of document that enable you to record the ideas, insights, interpretations or growing understanding of the material in your project. They provide a way to keep your analysis separate from (but linked
to) the material you are analyzing. Memos can evolve into an important part of the 'writing up' stage of your project—for example, they might lead into the chapters of a book or the outline of a presentation.

You can use memos to suit the needs of your project. For example, you can choose to

- Create memos for data files—capturing any issues, comments or insights that arise.
- Create memos for nodes—describing the significance of the node and the patterns or ideas that emerge from the references.
- Create 'unlinked' memos to store other information about your project such as research objectives or project progress.

If you have existing memos (perhaps as Word documents or PDFs) you can import memos into the Memos folder. You can create sub folders under the Memos folder to organise your memos. Memos can be automatically created when you import bibliographical data from reference management tools and are used to store reference notes.

If you want to use your memos when you write up or present your findings, you can export your memos and incorporate the content into your report or presentation.

To create a memo:

1. Select Memos default folder within the Notes area in the Navigation view.
2. On the Create tab of the ribbon in the Notes section choose Memo.
3. Name the memo, provide the Description if you wish, and click OK.
4. Double-click to open it in Detail View for adding text.
5. Make use of the editing tools (fonts, colours, heading styles etc.) available through the formatting bar as you add your thoughts to the journal.

![Task 6](image)

Task 6.

- Select Memos default folder within the Notes area in the Navigation view.
- On the Create tab of the ribbon in the Notes section choose Memo.
- Name the memo Definition of volunteering and click OK.
- Double-click to open it in Detail View for adding text.
- Type the following

  The New Thesaurus, Third Edition 1995:

  “volunteer”

  **NOUN:** Someone who offers his or her services freely.

  **VERB:** To put before another for acceptance: extend, offer, present, proffer, tender.

  **Idioms:** come forward with, lay at someone's feet, lay before.

Create linked memo

When you want to comment on the issues that arise from a data file or node, you can link to an existing memo or to a new memo—for example, while inspecting the content gathered at a node you can create and link to a memo that describes the patterns or ideas that are emerging.
Each data file in NVivo can optionally be assigned one primary memo, that is, a linked document for recording additional observations, reflections and other materials related to that item of data. Linked memos are also available for nodes.

To create a linked memo:

1. Select the data file or node in List View.
2. On the Home tab of the ribbon in the Item group, select Memo Link → Link to New Memo.
3. Give a name and description to the memo and click OK.
4. Once created, memos can be accessed by right-clicking on the mouse and selecting Memo Link → Open Linked Memo.

You can also link an existing memo to a file by selecting Link to Existing Memo in step 2.

Task 7.

- Select the document Bernadette in the Interviews folder of the Files in List View.
- On the Home tab of the ribbon in the Item group, select Memo Link → Link to New Memo.
- Name the memo Context of Bernadette’s interview and click OK.
- Once created, memo can be accessed by right-clicking on the mouse and selecting Memo Link → Open Linked Memo.
- Type the following text in the memo: Bernadette’s interview took place shortly after she had an unpleasant conversation with one of the volunteer supervisors. It is quite interesting that she can still talk about the overall volunteering experience very positively. This might speak to her motivations for volunteering and also what she feels is most important about her volunteering - the outcome rather than the process.

Links in Different Types of Data
(See Also Links and Hyperlinks)

How to:

- Create see also links within NVivo project
- Create hyperlinks to external data sources

Create see also links within NVivo project

Memos that are more thematic in content and refer to more than one project item can be linked via ‘see also links’. See also links can connect to more than one item and several links can be created within one project item. They can be created from text in documents, externals, memos, transcripts and picture logs, as well as audio files, videos or pictures.

You can use ‘see also’ links to draw connections between items in your project. For example, you can use ‘see also’ links to point out contradictions, follow evidence or show a sequence of events. The content you link from is highlighted in red and the link is displayed in the See Also tab at the bottom of Detail View.

You can link the content in a data file or a node to
an entire project item such as a document or a map:

part of another data file such as a selected paragraph or picture region

another part of the same data file

To create a 'see also' link to an existing document:

1. Select the content you want to link from.
2. On the Document tab, in the Links group, click See Also Link, and then click New See Also Link. The New See Also Link dialog box opens.
3. Click the Select button. The Select Project Item dialog box opens.
4. On the left, locate and select the folder that contains the file you want to link to.
5. On the right, select the file you want to link to.
6. Click OK to close the Select Project Item dialog box.
7. Click OK.

**Task 8.**
- Click on Files in the Navigation View, then select Interviews folder.
- Open the document named Anna.
In Q7 of this document select the following text Interviewer: show Images of Volunteers card
• On the Document tab, in the Links group, click See Also Link, and then click New See Also Link. The New See Also Link dialog box opens.
• Click the Select button. The Select Project Item dialog box opens.
• On the left, click on ‘+’ next to Files and select the Project documentation folder.
• On the right, select the Images of Volunteers file.
• Click OK to close the Select Project Item dialog box.
• Click OK.

To create a ‘see also’ link to specific content:

You can use the Copy and Paste As See Also Link commands to link to specific content in a file. For example, you could link a paragraph in a document to a region of a picture.

Note: You can also use the Copy and Paste as See Also Link commands to link to content in the same data source.

Task 9.
• Click on Files in the Navigation View, then select Interviews folder.
• Open the document named Fredric.
• In Q5a of this document select the last paragraph: I don’t know anyone who has gone overseas to do volunteer work. But you know, I think that’s more a self-indulgent thing, a chance to travel, and maybe your parents put in some of the costs because they see it as Developing You.
• On the Home tab, in the Clipboard group, click Copy.
• Select the last paragraph in Q4: If you mean full-time volunteer work, you know, going overseas for a while, I don’t think so. I’ve just got too many commitments here, work and so on.
• On the Home tab, in the Clipboard group, click the arrow below Paste, and then click Paste As See Also Link.

Task 10.
• Click on Files in the Navigation View, then select Interviews.
• Open the document named Fredric. Read Fredric’s responses to Q7a and Q7b. Notice, that he shows no skepticism about Ross being motivated by exotic travel, but Louise was.
• Select this fragment of Fredric’s interview.
• On the Document tab, in the Links group, click See Also Link, and then click New See Also Link. The New See Also Link dialog box opens.
Create hyperlinks to external data files

You can use hyperlinks in text-based data sources to link to web pages or files outside of your project. Hyperlinks are displayed with a blue underline.

Note:

- You can only add hyperlinks to documents, memos or externals.
- You cannot code, annotate or query web pages and files outside of your project. It may be better to create an external to represent the web page or file and paraphrase or make notes about the content. You can then code or annotate this material and link to the web page or file from the external.

To add a hyperlink:

1. Open the data file — you can only create hyperlinks in documents, memos and externals.
2. Make sure you are in edit mode!
3. Select the text you want to link from.
5. Enter the required website address or click the Browse button to locate a file.
6. Click OK.

Note: Hyperlinks are broken when the destination file is moved, renamed or deleted. If the link occurs in many data sources, it is recommended that you create one external to represent the website or file and link to the external from your data—this way if a hyperlink becomes invalid, you need only update it in one location.

Nodes and Coding

How to:

- Create nodes
- Code content for different types of data
- Manual coding of data
- Auto coding structured content

'Coding' your data files is a way of gathering all the references to a specific topic, theme, person or other entity. Before you begin coding your data, you should familiarize yourself with the concept of a node. This is the term used by NVivo to represent a code, theme, or idea about your data that you want to include in your project. You can code all types of data and bring the references together in a single 'node'. You can code manually within a data file or do some fast coding using the auto code and query-based coding features.
The way you approach the analysis of your data can depend on the
- Methodology you are using (if any)
- Amount and type of data you have
- Time available

NVivo does not prescribe an approach but provides the tools to let you work the way that suits you best. For example, if you have many data sources or you have large dataset files—make the most of NVivo's auto coding and query-based coding features. If you have a smaller number of data sources that require close analysis — take advantage of the easy-to-use manual coding tools.

Create nodes

You can create a node structure and then code your material at the 'ready-made' nodes or you can create nodes as you work through your data.

To create a free standing node:
2. Click on Create tab.
3. Select Node option – a new window will pop up.
4. Type in the name of the node and click OK.

To create a branch of the tree node:
1. Select the node (top of the tree) in List View.
2. Click on Create tab.
3. Select Node option – a new window will pop up.
4. Type in the name of the node and click OK.

Task 11
Using the instructions above, create the following nodes:
- Meanings of volunteer work
  - Chosen not required
  - Community work
  - Giving your time
  - Not real work
  - Unpaid
- Time
- Motivation

Code content for different types of data

In text-based data files you can select and code:
- Text—single letter, a few words, a whole passage or the entire data source
- Images
- Text and images in tables

In audio and video files you can code:
- A section of the media via the timeline
- Text in the Content field (column) of a transcript (if you have one)
NOTE: You cannot code text inside custom fields (columns), but you can use custom fields to auto code the whole transcript.

In picture files you can code:

- A region of the picture
- Text in the Content column of the picture log (if you have one)
- The entire picture

In survey datasets you can select and code:
- The entire data source—all content in codable fields is coded.
- Text in codable fields (columns)—a single word, a phrase, or a whole cell.
- A file shortcut
- An entire row—all content in codable fields within the row is coded.

You can identify codable fields by color — codable fields have a white background. You can code in Table View or in Form View.

NOTE: If you code a data file shortcut, the entire file (the file referenced in the shortcut) is coded. During import, you can choose which fields will be imported as codable fields.

**Manual coding of data**

While working with a data source you can select content and then code it in a new or existing nodes. NVivo provides the following ways to manually code your data:

- Select and code content using the options on the Home tab of the NVivo ribbon.
- Drag and drop selected content in a node in List View. You can customize your workspace to make the most of drag and drop coding—list the nodes on the left and display your data source on the right:
  - In Vivo code to make a new node from selected words or phrases.
  - Quick code using nicknames for common nodes—for example desalination could have the nickname desal. You select the content you want to code and enter or select the nickname.

To start coding a data source, click on Files in the Navigation View and select the data file you want to work with. Now you are ready to start coding. You probably have a document (or documents) open in Detail View with the list of tree nodes above.

To use Drag and Drop coding you have to have a list of nodes to drag and drop your text to! Read the text, highlight the text selection that can be coded into a specific node, highlight it, then drag the text and drop it on the node you wish.

**Task 12.**

- Open the document titled Anna.
- On the View tab, in the Workspace group, click on the pull-down menu under Detail View and choose Right. Click on the Nodes in the Navigation View. This will organize your space in a more efficient way for coding.
- Start reading the document and select content you want to code. On the Document tab, in the Coding group, click Code. In the dialog box choose relevant node or nodes and click OK.
- If you want to code into a new node, under Code click on the New Node. In the dialog box enter a name for the node and click OK.
Auto coding structured content

If you have applied heading styles in your text based file you can use them to automatically code the content. For example—if you have a collection of question/answer interview documents, you could auto code to create a node for each question (based on heading 1 and heading 2 styles) and code all respondent answers at the nodes.

NOTE: You can apply heading styles in Word before you import the data files, or you can apply them in NVivo.

To auto code using paragraph styles:

1. In List View, select the text based data files you want to auto code.
3. From the Code by list, select Paragraph Style, click Next.
4. From the Available paragraph styles list, select the styles you want to use for coding.
5. Click the right arrow button >> to add the styles to the Selected paragraph styles list.
   NOTE: A node is automatically created for each paragraph that is formatted in the selected style, and the text under the style is auto coded at the node. The order of the styles in the list determines how they are nested in the node hierarchy—the first style is the parent of the second and so on.
6. Under Code at Nodes, select where you want to store the newly created nodes.
7. Choose:
   a. Existing Node to store the created nodes under an existing node—click Select to display the Select Project Items dialog box, then select the node, and then click OK to close the dialog box.
   b. New Node to store the created nodes under a new node—click Select to display the Select Location dialog box, then select the location (for example, a folder or a node), and then click OK to close the dialog box. Enter a name for the new node.
8. Click Finish.

NOTE: If a heading contains reserved characters such as  ( \ : * ? " < > |  they are replaced by a tilde symbol (~) in the newly created node name.

Monitoring the Coding Process and Analyzing the Nodes

How to:

- Highlight coding
- Show and work with coding stripes

Highlight coding

When working with data sources and nodes in Detail View, you can highlight the content that has been coded at selected nodes, as well as the content at cases with selected attribute values, and the content coded by selected users. Highlighted content is displayed with a yellow background.

To highlight coding for selected nodes, click on the Document tab on the ribbon, select Highlight and click the Coding Selected Items option. In the Select Project Items dialog, click the checkbox for the required nodes and then click OK.
Show and work with coding stripes

Coding stripes are coloured bars that enable you to see the:

- Nodes that code content
- Attributes of content coded at a case
- Coding by specific NVivo users (useful when you are working in a team).

To show coding stripes, select Coding Stripes option in the Document tab of the ribbon. There are a number of different display options. The default number of coding stripes displayed is seven. You can increase this number up to 200 stripes via the Application Options. Select the File > Options tab. Click the Display tab. Then, at the coding stripes panel, change the maximum number of stripes to your preference.

Working with Your Nodes

How to:

- Open and view the content of nodes in various ways
- Uncode and ‘code on’
- Move, sort and merge nodes
- Export a node

Open and view the content of nodes in various ways

Once you have coded data at your nodes, you can look at the contents of any node and continue working with your data. To open a node, double-click on it in the List View. There are a series of tabs on the right-hand side of the node. By default the node opens showing all references. You can also choose to view the summary which lists all the files coded at the node. Also, depending on which type of data file the coding is from, a Text, Picture, Audio or Video tab is available – click each tab to view the content in that format.

When you open a node, it’s a ‘live’ node which references back to the data file. If you make a change to the data file such as changing the colour of the font, the node is immediately updated.

The node Reference view looks very much like the data source Detail View. The text represents the coding that has been done at this node. It may include content from a document, external, memo, transcript or picture log, or it may include content from a region of a picture or media timeline.

Uncode and ‘code on’

There may be times when you have coded text selection, a media timeline or a region of a picture that needs to be uncoded. The same process applies for uncoding content from any data file or a node.

To uncode a selection of content from a node:

1. Open the node and click on the Node tab, then select the piece that you wish to uncode.
2. Choose Uncode from This Node option.

You can also do further coding, known as ‘coding on’ by selecting text in a node and coding to other nodes, or by selecting a section of a coded timeline in a media file or region of a picture.

Move, sort and merge nodes
Using software to conduct your research gives you the flexibility to shape your data and project. At some point, you may need to reorganize your nodes. You may want to move free nodes into tree nodes, move a tree node down the hierarchy, merge some nodes that have the same meaning or rename a node. Before rearranging your nodes, save your project and if you do make a mistake, remember the undo button is available from the Main toolbar.

To move a free node(s) into a tree node:
1. Select a free node(s), right-click on the mouse and click Cut.
2. Select the tree node that you want to move the free node to, right-click on the mouse and click Paste, and then Yes.

To move a branch from the tree node into a free node format:
1. Select a free node, right-click on the mouse and click Cut.
2. Select the Nodes in the Navigation View, right-click on the mouse and click Paste, and then Yes.

To merge nodes:
1. Select the required node, right-click and choose Cut.
2. Select the target node, right-click and choose Merge into Selected Node.
3. Select the options you wish from the Merge into Node dialog and click OK.

Note: There is no indication in the target node that coding was merged from another node. If this important for your research, add a note to a memo or journal document.

To rename a node:
1. Select the node, right-click and select properties.
2. Change the name and/or description of the node.
3. Click OK.

Export nodes

Export a node summary

You can export a table of all the data files that have been coded at a node, including information about the number of references and percentage of coding. You can export this summary in the following formats:

- Microsoft Excel Worksheet (.xlsx, .xls)
- Plain text (.txt)
- Microsoft Word (.docx, .doc)
- Rich text (.rtf)
- Adobe PDF (.pdf)

To export a node summary:
1. In List View, select the node you want to export.
3. From the Export list, select Summary View.
4. To display the exported node after exporting, select the Open on Export check box.
5. Click OK. The Save As dialog box opens.
6. The exported file is saved to your default location for exported files, you can choose a different location if necessary.
7. In the File name box, review the name that NVivo proposes for the exported file, and change it if necessary.
8. In the **Save as** type box, choose the file format for the exported file.
9. Click **Save**.

**NOTE:** If you export a parent node with node aggregation turned on, the exported node includes content coded at the parent and content coded at all of the child nodes.

**Task 13.**
- In **List View**, select the node *Time*.
- On the **Share** tab, in the **Export** group, click **Export**. The **Export Options** dialog box opens.
- From the **Export** list, select **Summary View**.
- To display the exported node after exporting, select the **Open on Export** check box.
- Click **OK**.

### Export the references in a node

You can export all the references in a node (including text content and information about the media content). You can export the references in the following formats:
- Plain text (.txt)
- Microsoft Word (.docx, .doc)
- Rich text (.rtf)
- Adobe PDF (.pdf)

To export the references in a node:
1. In **List View**, select the node you want to export.
2. On the **Share** tab, in the **Export** group, click **Export**. The **Export Options** dialog box opens.
3. From the **Export** list, select **Reference View**.
4. Select the required options.
5. To display the exported node after exporting, select the **Open on Export** check box.
6. Click **OK**. The **Save As** dialog box opens.
7. The exported file is saved to your default location for exported files, you can choose a different location if necessary.
8. In the **File name** box, review the name that NVivo proposes for the exported file, and change it if necessary.
9. In the **Save as** type box, choose the file format for the exported file.
10. Click **Save**.

**Task 14.**
- In **List View**, select the node *Time*.
- On the **Share** tab, in the **Export** group, click **Export**. The **Export Options** dialog box opens.
- From the **Export** list, select **Reference View**.
- To display the exported node after exporting, select the **Open on Export** check box.
- Click **OK**.

### Export all node content as HTML web pages (including audio and video)

You can export the entire content of a node to make a 'mini website'—this is a great way to share your findings (including audio and video clips) with colleagues who don't have NVivo:

1. In **List View**, select the node you want to export.
3. From the Export list, select Entire Content.
4. Select the required options.
5. To see the exported HTML pages, select the Open on Export check box.
6. Click OK.

NOTE:
- The node is exported as a series of web pages that are stored in your 'My Documents' folder. The 'home' page has the same name as the exported node (for example, adapting to climate change.htm). You can open this file to access the 'mini website'.
- If you want to move the web pages, make sure you copy all the .HTM files to the new location.
- If you export a parent node with node aggregation turned on, the exported node includes content coded at the parent and content coded at all of the child nodes.

Task 15.
- In List View, select the node Time.
- On the Share tab, in the Export group, click Export. The Export Options dialog box opens.
- From the Export list, select Entire Content.
- To display the exported node after exporting, select the Open on Export check box.
- Click OK.

Export the node hierarchy

You can export the node structure as it appears in List View—click the plus or minus symbols to expand or collapse the hierarchy as required.

You can export the node list in the following formats:
- Microsoft Excel Worksheet (.xlsx, .xls)
- Plain text (.txt)
- Microsoft Word (.docx, .doc)
- Rich text (.rtf)
- Adobe PDF (.pdf)

1. In List View, select the node you want to export.
2. On the Data tab, in the Export group, click Export List. The Save As dialog box opens.
3. The exported file is saved to your default location for exported files, you can choose a different location if necessary.
4. In the File name box, review the name that NVivo proposes for the exported file, and change it if necessary.
5. In the Save as type box, choose the file format for the exported file.
6. Click Save.

Task 16.
- On the Share tab, in the Export group, click Export List. The Save As dialog box opens.
- Choose a name and location for the exported file.
- Click OK.
Additional Learning Resources

1. NVivo Getting Started Resources: http://www.qsrinternational.com/learning/Getting-Started
4. NVivo Knowledge Center: http://www.qsrinternational.com/Free-NVivo-Resources/Knowledge-Center